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Introduction
Financial Inflation Adjustment is a tool that allows you to adjust your non monetary
accounts for inflation for the fiscal periods that you have set up. Journal entries for
the adjustment are created in General Ledger, from where you can post them.

Check for current instructions
This information was current as of February 2007. The documentation may be
updated as new information becomes available. Check the Microsoft Dynamics GP
online Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most
current documentation.
The introduction is divided into the following sections:
•
•
•
•

What’s in this manual
Symbols and conventions
Resources available from the Help menu
Send us your documentation comments

What’s in this manual
This manual is designed to give you an in-depth understanding of how to use the
features of Financial Inflation Adjustment, and how it integrates with the Microsoft
Dynamics™ GP system.
To make best use of Financial Inflation Adjustment, you should be familiar with
systemwide features described in the System User’s Guide, the System Setup
Guide, and the System Administrator’s Guide.
Some features described in the documentation are optional and can be purchased
through your Microsoft Dynamics GP partner.
To view information about the release of Microsoft Dynamics GP that you’re using
and which modules or features you are registered to use, choose Help >> About
Microsoft Dynamics GP.
This manual is divided into the following chapters:
•

Chapter 1, “Setup and routines,” explains how to set up Financial Inflation
Adjustment for your company. You can select the accounts for which to perform
inflation adjustment. You can perform the inflation adjustment for a selected
period according to the inflation index specified by the authorities.

•

Chapter 2, “Inquiries,” describes how you can post the adjustment entries from
General Ledger. You can view the details for adjustments you have posted for a
selected period.
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Symbols and conventions
For definitions of unfamiliar terms, see the glossary in the manual or refer to the
glossary in Help.
Symbol

Description
The light bulb symbol indicates helpful tips, shortcuts and
suggestions.
The warning symbol indicates situations you should be
especially aware of when completing tasks.

This manual uses the following conventions to refer to sections, navigation and
other information.
Convention

Description

Creating a batch

Italicized type indicates the name of a section or procedure.

File >> Print or File >
Print

The (>>) or (>) symbol indicates a sequence of actions, such as
selecting items from a menu or toolbar, or pressing buttons in
a window. This example directs you to go to the File menu and
choose Print.

TAB

or ENTER

All capital letters indicate a key or a key sequence.

Resources available from the Help menu
The Microsoft Dynamics GP Help menu gives you access to user assistance
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays
the main “contents” topic. To browse a more detailed table of contents, click the
Contents tab above the Help navigation pane. Items in the contents topic and tab
are arranged by module. If the contents for the active component includes an
“Additional Help files” topic, click the links to view separate Help files that
describe additional components.
To find information in Help by using the index or full-text search, click the
appropriate tab above the navigation pane, and type the keyword to find.
To save the link to a topic in the Help, select a topic and then select the Favorites tab.
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the
Index tab active. To find information about a window that’s not currently displayed,
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics
and descriptions of the fields, buttons, and menus for the window, choose the
appropriate link in the topic. You also can press F1 to display Help about the current
window.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window.
For example, if the Checkbook Maintenance window is open, you can choose this
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain
information before you can save the record and close the window. You can change
the font color and style used to highlight required fields. On the Microsoft
Dynamics GPmenu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within
Microsoft Dynamics GP. Additional tutorials are available through the
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance
resources. Access to some items requires registration for a paid support plan.
Current implementation and upgrade information The most recent
revisions of upgrade and implementation documentation, plus documentation
for service packs and payroll tax updates.
User documentation and resources The most recent user guides, howto articles, and white papers for users.
Developer documentation and resources The most recent
documentation and updated information for developers.
Product support information Information about the Microsoft Dynamics
GP product support plans and options that are available, along with
information about peer support and self-support resources.
Services information Information about Microsoft Dynamics GP support,
training, and consulting services.
Microsoft Dynamics GP Community Access to newsgroups, where you
can ask questions or share your expertise with other Microsoft Dynamics GP
users.
CustomerSource home page A wide range of resources available to
customers who are registered for a paid support plan. Includes access to
Knowledge Base articles, software downloads, self-support, and much more.
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U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you
select an option, the process to install the updates will begin immediately.
Check with your system administrator before installing tax updates. To be sure that tax
updates are installed correctly, refer to documentation for specific tax updates on the
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience
Improvement Program to improve the quality, reliability, and performance of
Microsoft® software and services.

Send us your documentation comments
We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.
To send comments about specific topics from within Help, click the Documentation
Feedback link, which is located at the bottom of each Help topic.
Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Chapter 1:

Setup and routines
Use this information to install Financial Inflation Adjustment, and to select the
accounts for which to perform inflation adjustment. You can perform the
adjustment for a specific period of the fiscal years that you’ve set up in Microsoft
Dynamics GP.
This information is divided into the following sections:
•
•
•
•

Selecting accounts
Viewing the selected accounts
Adjusting inflation for a period
Entering the inflation adjustment index

Selecting accounts
You can select the financial accounts to include in the inflation adjustment. You
must adjust these accounts for inflation at the end of every fiscal period, based on
the inflation percentage specified by the legal authorities.

To select accounts:
1.

Open the Inflation Adjustment Account window.
(Cards >> Financial >> Account >> select an account >> Additional >> Inflation
Adjustment)

2.

Mark the Adjust for Inflation checkbox for the selected account.

3.

Enter or select an account to be debited with the inflation adjustment amount, if
any.

4.

Enter or select an account to be credited with the monetary correction amount,
if any.

5.

Choose OK to save the values you’ve entered and return to the Account
Maintenance window.

Viewing the selected accounts
You can print a report for the accounts that you have marked for inflation
adjustment in the Chart of Accounts Report window. The Chart of Reports window
has a report option for inflation adjustment. Use this option to first create a report
option for the inflation adjustment report. Refer to the General Ledger
documentation for more information on creating report options.
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To view the selected accounts:
1.

Open the Chart of Accounts Report window.
(Reports >> Financial >> Account)

2.

Select Inflation Adjustments in the Reports list. The Options field displays all
the report options you have set up for Inflation Adjustment.

3.

Select a report option, and choose Insert to insert it into the Print list. You can
select multiple report options to print.

4.

Choose Print to view and print reports based on the options you have selected.

Entering the inflation adjustment index
You can enter the adjustment index for each period of each fiscal year that you have
set up in Microsoft Dynamics GP.

To enter the inflation adjustment index:
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1.

Open the Inflation Percentages - Fiscal Periods window.
(Microsoft Dynamics GP menu >> Tools >> Routines >> Financial >> Inflation
Adjustments >> Adjustment Year expansion button)

2.

Select the year for which to enter the adjustment indices. The scrolling window
displays the details for all the periods set up for the selected year.

3.

Enter the adjustment index for each period in the respective Index field.

4.

Choose OK to close the window after entering the required indices.
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Adjusting inflation for a period
Use the Inflation Adjustments window to adjust the inflation for a specific period of
a fiscal year. You can enter the inflation percentage for a period in the Inflation
Percentages - Fiscal Period window. Refer to Entering the inflation adjustment index
on page 6 for more information.

To adjust inflation for a period:
1.

Open the Inflation Adjustments window.
(Microsoft Dynamics GP menu >> Tools >> Routines >> Financial >> Inflation
Adjustments)

2.

Select the year for which to perform the adjustment. Select the Adjustment Year
expansion button to open the Income Percentages - Fiscal Periods window,
where you can enter or change the percentage for one or more periods of a year.

3.

Select the adjustment period. The Inflation Index field displays the percentage
you entered for the period in the Income Percentages - Fiscal Period window.
You can change this value.

4.

In the Results field, select Report to view a report before posting the
adjustment. Choose Post to post the adjustment after verifying that the values
on the report are accurate.

5.

Enter the posting date to post the adjustment. The default date is the current
user date.

6.

Choose Adjust to view the report or to post the adjustment, depending on your
selection in the Results field.

7.

Choose Cancel to close the window without adjusting for inflation.
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Chapter 2:

Inquiries
Use this information to view the adjustments you posted. You can also view the
journal entries that are created in General Ledger after posting the inflation
adjustment.
Financial Inflation Adjustment reports are available in the report list. You can select
a report in the report list and add it to My Reports for easy access. Refer to the
Microsoft Dynamics GP documentation for more information.
This information is divided into the following sections:
•
•

Viewing posted adjustments
Posting adjustment entries from General Ledger

Posting adjustment entries from General Ledger
When you post an inflation adjustment, journal entries are created in General
Ledger. The source document ID for these journal entries is GLAJINF. You can view
these journal entries in the Transaction Entry window (Transactions >> Financial >>
General).

Use the Batch Entry window (Transactions >> Financial >> Batches), and select
GLAJINF as the batch ID to post these entries from General Ledger. Refer to the
General Ledger documentation for more information on posting batches from
General Ledger.

Viewing posted adjustments
You can view the details of the adjustments that you posted to the General Ledger
in the Inflation Adjustment Inquiry window.
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To view posted adjustments:
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1.

Open the Inflation Adjustment Inquiry window.
(Inquiry >> Financial >> Inflation Adjustment)

2.

Select to view the adjustments for all years, or enter a year range.

3.

Choose Redisplay to display the adjustments for the selected years in the
scrolling window. The scrolling window displays the year, period, inflation
index and the adjustment amount for each adjustment.

4.

Select an adjustment, and click the Accounting Journal link to open the Journal
Entry Inquiry window. You can view the details of the journal entry created for
the adjustment in General Ledger.

5.

Choose OK to close the window.
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Glossary
Inflation adjustment index
Values that are used to adjust the inflation
for a specific period of a fiscal year.

F I N A N C I A L I N F L A TI O N A D J U S T M E N T

11

12

F I N A N C I A L

I N F L A T I O N

A D J U S T M E N T

Index
A
adjusting inflation, for a period 7
adjustment entries, viewing in General
Ledger 9
adjustment index, entering 6
adjustments
posting in a batch 9
viewing posted 9

U
upgrade information, accessing on the
Web 3

V
viewing, selected accounts 5

W
what’s new, accessing 3

B
batch posting, adjustment entries 9

C
changes since last release, information
about 3
Chart of Accounts Report window,
displaying 6
current upgrade information, accessing on
the Web 3

D
documentation, symbols and conventions
2

H
help, displaying 2
Help menu, described 2

I
icons, used in manual 2
index of adjustment, entering 6
inflation, adjusting 7
inflation adjustment, introduction 1
Inflation Adjustment Account window,
displaying 5
Inflation Adjustment Inquiry window,
displaying 10
Inflation Adjustments window, displaying
7

L
lessons, accessing 3
lookup window, displaying 3

N
new features, information about 3

O
Orientation training, accessing 3

R
required fields, described 3
resources, documentation 2

S
selecting accounts, for adjustment 5
symbols, used in manual 2

T
tutorial, accessing 3
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